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3D Slicer version 4 (Slicer4)

An end-user application for
image analysis

An open-source
environment for software
development

A software platform that is
both easy to use for clinical
researchers and easy to
extend for programmers



Slicer4 Highlights: Python

The Python console of Slicer4 gives access to
scene objects (MRML)
data arrays (volumes, models)
GUI elements that can be encapsulated in a
module

Processing Libraries: numpy, VTK, ITK,
custom code



Slicer4 Scripted Module

Python scripted modules allow more
interactive functionalities (eg ‘Flythrough’ in
Endoscopy module)

GUI based on Qt libraries accessed via Python

@ python’



Tutorial Goal

This tutorial guides you through the steps of
programming a HelloPython scripted module
for running a Laplacian filtering and
sharpening.

For additional details and pointers, visit the

Slicer Documentation page
http://wiki.slicer.org/slicerWiki/index.php/Documentation/4.0




Processing Examples in this
Tutorial

Manipulation
@ with numpy

3DSlicer

Image Data on

Disk (DICOM,

Nifti, nrrd...) . — A

S Manipulation

with VTK

Manipulation
with ITK

the Slicer Data Representation (Slicer CLI)

MRML: Medical Reality Markup Language,



Prerequisites

This course supposes that you have taken the
tutorial: “Slicer4 Data Loading and
Visualization”- Sonia Pujol Ph.D.

The tutorial is available on the Slicer4 101
compendium:

* Programming experience is required, and
some familiarity with Python is essential.



Course Material

Unzip the HelloPython.zip archive

spgr.nhdr spgr.raw.gz =
(124 SPGR images)
HelloPython.py
HelloLaplace.py

HelloSharpen.py



Course Overview

Part A: Exploring Slicer via Python

Part B: Integration of the HelloPython.py
program into Slicerd

Part C: Implementation of the Laplace
operator in the HelloPython module

Part D: Image Sharpening using the Laplace
operator



@ python’

Part A: EXPLORING SLICER VIA
PYTHON



Python in Slicer

Slicer 4 includes python 2.6.6 and a rich
standard library
Included: numpy, vtk, ctk, PythonQt, most of
standard python library
Not Included: scipy, matplotlib, ipython...
and some other popular packages that we
have found difficult to package for
distribution



Python Console in Slicer

¢-.“)‘) Q{{\Wo%_@/ E;tv Persistentkbghv v

@ ERR 5:0.00% 1

= O€lect View ->  Python Interactor to
™ launch the Python console of Slicer

| » About

| » The Main Window

| » Loading and Saving

| » Display

| » Mouse & Keyboard

| » Documentation & Tutorials

) SllcerQT—real

| » Acknowledgment

Python 2.6.6 (r266:84292, Mar 1 2012, 12:53:23)
[GCC 4.4.5] on linux2 %
>>>

v Data Probe

m




General Python Console Features

Command Line Editing:
Left/Right Arrow Keys, Home, End
Delete (Control-D)
Input History
Up/Down Arrow Keys
Command Completion
Tab Key st oo, e s



Add Volume Dialog

Yew Help
Modules: £\ Welcome to Slicer s m— {D 2 @ QO @ Z A 1| § v Persistent qa S v
@® ;L

£ - Select File -> Add Volume
Welcome

[Gtsy Load DICOM Data oo, Load Data
{#: Customize Slicer O Download Sample Data

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard

v

Documentation & Tutorials

v

Acknowledgment

¥ Data Probe

-

None RAS: (125.0, -125.0, 1.0),



Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




Access to MRML and Arrays

File Edit View Help

£ - f—
”i‘l"‘} &,WJ Modules &) Welcome to Slicer =

- Run the following code in the

>>> a = slicer.util.array('spgr')
>>> print(a)]

Python 2.6.6 (r266:84292, Mar 15 2012, 03:03:01) P th I
[GCC 4.2.1 (Apple Inc. build 5666) W y On ConSO e

ta

le Data
a = slicer.util.array('spgr’)
e e Z - Uses the slicer.util package to
S return a numpy array of the image
— —>The variable 'a' is a numpy ndarray
: y of the volume data we just loaded
Documentation & Tutorials
» Acknowledgment - 17

print( a)

—>Shows a shortened view of the array

¥ Data Probe




Access to MRML and Arrays

File Edit View Help

ﬁ‘lj Modules:
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Loading and Saving
Display
Mouse & Keyboard

Documentation & Tutorials

» Acknowledgment

v

-

Data Probe

/'ir A Y O 4% Z 7 | 4 ~ | Ppersistent @ = S v

The intensity values of the spgr
Image appear in the Python
console

mple Data

= R = 5:-27.53 | - R: 2.30 |G e A:13.77




Access to MRML and Arrays

File Edit View Help

Modules:

) Welcome to Slicer

a | ”
e Al

800
(000 ..., 000]
[131...,222]
(113 ...,121]
[6 73 ..., 235]
[56 3 r 2 3 4]]
[[000 ..., 000]
[000 ..., 000]
[210...,100]
(221 ..., 12 2]
[040 ..., 01 3]
[030 ..., 012]]]

>>> print(a.min(),a.max())

[»]f

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

¥ Data Probe

-

Type the following command to
display the min and max
intensity value of the spgr image

print( a.min(), a.max() )

—>Use numpy array methods
to analyze the data




Access to MRML and Arrays

File Edit View Help

Modules: £\ Welcome to Slicer | - o A @ -

- Imin=0;Imax=355

(113 ...,121] ]
(673 ..., 235]
(563 ..., 23 4]]
[[000 ..., 000]
[000 ..., 000]
210 ..., 100]
(221 ...,122] i
[040 ..., 01 3]
[030 ..., 01 2]]] L
>>> print(a.min(),a.max())
(0, 355) u
>>> ) ) 7
» Display
» Mouse & Keyboard
» Documentation & Tutorials
» Acknowledgment B REE= ]S:-2753 |~ Y &% =——

¥ Data Probe

-




Manipulating Arrays

5

Run the following code in the

Python console

CCCCCC

def toggle():
n = slicer.util.getNode('spgr')
a = slicer.util.array('spgr')
a[:] = a.max()/2. - a
n.GetlmageData().Modified()
print("Toggled')

toggle()

[(./ "5 < \‘\ jF \:::*,ﬁ- v ’
e A\ W

For practice: use up arrow and return
keys to execute toggle() over and over



Manipulating Arrays

File Edit View Help
@ Modules: &Y Welcome to Slicer 4| - o A ;;ﬂ. I A BA_ L IR Lo 8w oo SNIU == R

1555 def toggle ():
. = slicer.util.getNode('spgr')

1
:
= 1
1
!E ghslicer = slicer.util.array('spgr’) :
a[]-amx()/Z - a !
Welcome n.GetImageData () .Modified() :
print ('Toggled’) |
1
- 1
[y Load DICOM Data [oacy Load Data >>> toggle() :
{#: Customize Slicer O Download Sample Data Togg'led :
FPI> :

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard
» Documentation & Tutorials

» Acknowledgment

¥ Data Probe

m ™M



The toggle function in More Detalil

def toggle():
Defines a python function
Body of function performs element-wise
math on entire volume
Easy mix of scalar and volume math
Telling slicer that the image data for node 'n’
has been modified causes the slice view windows
to refresh



Qt GUI in Python

Run the following code in the
Python console

b = qt.QPushButton("Toggle")
b.connect('clicked()', toggle)
b.show()

What do you think will happen when you
run this code? What about when you
push the button?



Result with button toggling

CIREE S:-27.53 |#1 1 |

»| @ 4+ |Axial + [spgr




Result with button toggling

CIR

»| @ | < |Axial $ | spgr




In More Detail

Slicer uses PythonQt to expose the Qt library*
Sophisticated interactive modules can be
written entirely with Python code calling C++
code that is wrapped in Python

See Endoscopy, Editor, SampleData,
ChangeTracker, and other slicer modules in

the Slicer source code

(*) Qt: http://gt.nokia.com (**) PythonQt: http://pythonqt.sf.net /
F.Link (MeVis)



# Hellopython
"

class
def (self, parent)
parent. title = “He
parent. categories = [ 1
parent . dependencie:
parent. contributors = [

1 # replace with “Firstnane Lastnane (0rg)
parent.helpText =

parent..acknowledgenentText =

¥ Help & Acknowledgement

# replace with organization, grant and thanks
self.parent = parent

Help | Acknowledgement

ey e tone) Example of scripted loadable extension for the HelloPython tutorial.

self.parent = slicer.quRMLWidget ()
self.parent. setLayout (qt.QVBoxLayout ())
self.parent. setMRHLScene slicer.mrmlScene)

else
self.parent = parent

self.layout = self.parent.layout()

self.parent. show()

def (self)
# Instantiate and connect widgets

# Collapsible button
dunmyCol lapsibleButton = ctk.ctkCollapsibleButton()
dunmyCol LapsibleButton. text =

T epout adartdoet ummyCatLaps oL chution) v A collapsible button
dunmyFormLayout = qt.QFormLayout (dummyCollapsibleButton)

Hello world

# Add vertical spacer
self.layout . addStretch(1)

# set loc as instance attribute
self.helloworldButtor LoWor1dButton

det tt (self)
qt.QMessageBox. information(slicer.util.mainWindow(),

JHellopython.py

PART B: INTEGRATION OF THE
HELLOPYHTON TUTORIALTO
SLICER4



HelloPython.py

X=8
File Edit Tools

elp
B ld@a LIk BE,

from _main__ import vtk, qt, ctk, slicer

ﬂ"&D'& gg

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar‘ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloPython.py
located in the directory HelloPython

# Helloworia putton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




Module
Description

Module GUI

Processing
Code

HelloPython.py

X =0
File Edit T

from _ main__ import vtk, qt, ctk, slicer
#

# HelloPython

#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roaf§nap for Medical Research, Grant US54 EBO©5149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonWidget
#

class HelloPythonWidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() %

if not parent:
self.setup()
self.parent.show()

def setup(self):
# Instantiate and connect widgets ...

# Collapsible button

dummyCollapsibleButton = ctk.ctkCollapsibleButton()
dummyCollapsibleButton.text = "A collapsible button”
self.layout.addwidget (dummyCollapsibleButton)

# Layout within the dummy collapsible button
dummyFormLayout = qt.QFormLayout(dummyCollapsibleButton)

# Helloworld button

hellowWorldButton = qt.QPushButton("Hello world")
helloworldButton.toolTip = "Print 'Hello world' in standard ouput."”
dummyFormLayout.addwWidget (hellowWorldButton)
helloWorldButton.connect('clicked(bool)', self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloworldButton = helloWorldButton

def onHelloWorldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), ‘'Slicer Python', ‘Hello World!')

LloPython.py 22,8 ALUM




Module Description

class HelloPython:
def __init_ (self, parent):

parent.title = "Hello Python"

parent.categories = ["Examples"]

parent.dependencies = []

parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware)",
"Steve Pieper (Isomics)",
"Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"

parent.helpText = """

This code is Example of scripted loadable extension for the HelloPython tutorial.

provided in
the template

parent.acknowledgementText =

This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through
the NIH Roadmap for Medical Research, Grant U54 EB005149."" # replace with organization,
grant and thanks.

self.parent = parent



Module GUI

# HelloWorld button

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print ‘Hello world' in standard ouput.”
sampleFormLayout.addWidget(helloWorldButton)
helloWorldButton.connect(‘clicked(bool)’, self.onHelloWorldButtonClicked)




Processing Code

qt.QMessageBox.information(
slicer.util.mainWindow(),
'Slicer Python', 'Hello World!')




Integrating HelloPython

Open the side
panel and click

_
Add

General settings
e T Fi T Skip loading of: loadable modules (—disable-load

Extensions settings command-line plugins (—-disable-c.....co...C,
Cache settings
Python settings
Volume rendering Prefer Executable CLlIs:

Show hidden modules:

scripted loadable modules (--disable-scripted-loadakljle-mo

Temporary directory: P /tmp/Slicer

Additional module paths:

Select Module Settings
f the : :gscs-lc’raalgffsgmmes
rom ¥| Affine Registration

Edit -> Application &
Settings Dialog |

&) Welcome to Slicer -

A @ o Transforms @ /

Volumes Models Annotations

* Restart requested

'_ Reset H Restore Defaults




Integrating HelloPython

Add the path to the
directory containing

Y S folder
He”OPythOnpy e/pieper/Dropbox/O.‘.elloW OO0 D& @ @
(when selecting the e B |Wpe | DateModit

directory, the
HelloWorld.py file itself
will not be displayed)

4 »

Files of type: = x Cancel




B o HelloPython in Slicer

All Modules »

Restart Slicer when prompted.

Z] Annotations
®

o oo Hello Python is now in the
& o Modules Menu can can be

Ka Scene Views used '
4 Transforms =
™ view Controllers
@ Volume Rendering
& Volumes

£\ Welcome to Slicer

Wizards »

Informatics » ¥ Help & Acknowledgement

Registration' g Help | Acknowledgement

Segmentation g Example of scripted loadable extension for the HelloPython tutorial.
Quantification 4

Diffusion 4

IGT 4

Filtering 4

Surface Models » ¥ A collapsible button

Converters g Hello world
Endoscopy 4

Utilities 4

Developer Tools »

Legacy 4

Testing 4

Work in Progress 4



3DSlicer

Part C:
Implementing the
Laplace™ Operator

*named after Pierre-Simon, Marquis de Laplace (1749-1827)




Goals of this part

Build an image analysis module that
implements a Laplacian filter on volume data
Use gMRML widgets: widgets that
automatically track the state of the Slicer
MRML scene
Use VTK filters to manipulate volume
data
Manipulate the slice views to display
result



HelloLaplace.py

X=0

File Edit Tools

SRR SE wh e =N

from _main__ import vtk, qt, ctk, slicer

s [ El
=

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar’ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloLaplace.py
located in the directory HelloPython

# Helloworia outton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




This code is
provided in
the template

Module GUI (Part 1)

def setup(self):

# Collapsible button

self.laplaceCollapsibleButton = ctk.ctkCollapsibleButton()
self.laplaceCollapsibleButton.text = "Laplace Operator"
self.layout.addWidget(self.laplaceCollapsibleButton)

# Layout within the laplace collapsible button
self.laplaceFormLayout = qt. QFormLayout(self.laplaceCollapsibleButton)

# the volume selectors

self.inputFrame = qt.QFrame(self.laplaceCollapsibleButton)
self.inputFrame.setLayout(qt.QHBoxLayout())
self.laplaceFormLayout.addWidget(self.inputFrame)
self.inputSelector = qt.QLabel("Input Volume: ", self.inputFrame)
self.inputFrame.layout().addWidget(self.inputSelector)
self.inputSelector = slicer.gMRMLNodeComboBox(self.inputFrame)
self.inputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), ")
self.inputSelector.addEnabled = False
self.inputSelector.removeEnabled = False
self.inputSelector.setMRMLScene( slicer.mrmIScene )
self.inputFrame.layout().addWidget(self.inputSelector)



This code is
provided in
the template

Module GUI (Part 2)

self.outputFrame = qt.QFrame(self.laplaceCollapsibleButton)
self.outputFrame.setLayout(gt. QHBoxLayout())
self.laplaceFormLayout.addWidget(self.outputFrame)
self.outputSelector = qt.QLabel("Output Volume: ", self.outputFrame)
self.outputFrame.layout().addWidget(self.outputSelector)
self.outputSelector = slicer.gMRMLNodeComboBox(self.outputFrame)
self.outputSelector.nodeTypes = ( ("vtkMRMLScalarVolumeNode"), " )
self.outputSelector.setMRMLScene( slicer.mrmIScene )
self.outputFrame.layout().addWidget(self.outputSelector)

# Apply button

laplaceButton = qt.QPushButton("Apply Laplace")
laplaceButton.toolTip = "Run the Laplace Operator."
self.laplaceFormLayout.addWidget(laplaceButton)
laplaceButton.connect('clicked(bool)', self.onApply)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.laplaceButton = laplaceButton



In More Detail

Qt Widgets, Layouts, and Options are well
documented at http://gt.nokia.com

CTK is a Qt Add-On Library with many useful
widgets, particularly for visualization and medical
imaging see http://commontk.org
qgMRMLNodeComboBox is a powerful slicer widget
that monitors the scene and allows you to select/
create nodes of specified types (here we use
Volumes = vtkMRMLScalarVolumeNode)



B o Processing Code

_ laplacian = vtk.vtkimageLaplacian()
Add this laplacian.SetInput(inputVolume.GetimageData())
code laplacian.SetDimensionality(3)
laplacian.GetOutput().Update()



In More Detail

vtkimagelaplacian is a vtkimageAlgorithm operates
on vtkimageData (see http://vtk.org)
vtkMRMLScalarVolumeNode is a Slicer MRML class
that contains vtklmageData, plus orientation
information ijkToRAS matrix (see http://
www.slicer.org/slicerWiki/index.php/
Coordinate_systems)

gMRMLNodeComboBox is a Slicer widget that gives
direct access to volume nodes in the scene



In More Detail (Continued)

Global slicer module gives python access to
GUI (via slicer.app), modules (via
slicer.modules) and data (via
slicer.mrmlScene).
slicer.app.applicationLogic() provides helper
utilities for manipulating Slicer state



Go To Laplace Module

e s~ 00 n sso .  Re-start Slicer and select

\ 7

All Modules @® R =1

: module. Note that

& picom
‘e : combobox is empty

4 Transforms B
I View Controllers =
@ Volume Rendering

§ Volumes File Edit View Help
£\ Welcome to Slicer

[ eemples . EETIT l Modules: ‘- | Hello Python Part C - Laplace & | ™ Q </ {h FAS ﬁ (-

Wizards Hello Python Part C - Laplace
Hello Python Part D - S rpen

O

—
“

T

Informatics

Registration
Segmentation
Quantification

K = “‘ 3DSlicer
Diffusion !
IGT

»
>
»
>
4
>
>
Filtering ’ » Help & Acknowledgement
Surface Models 4
>
>
4
>
>
>

Converters
Endoscopy ¥ Laplace Operator
Utilities
Developer Tools Input Volume: | Select a Volume [} =
Legacy
Testin
9 Output Volume: | Select a Volume =
Work in Progress > e

Apply Laplace




Add Volume Dialog

Wew Help
= Modules: £\ Welcome to Slicer 3| = AP O & 4 7 1| § v | Persistent o 5 -
5) "EL

£ - Select File -> Add Volume
Welcome

[Gitay Load DICOM Data ey Load Data
{#: Customize Slicer O Download Sample Data

v

About

v

The Main Window

v

Loading and Saving

v

Display

v

Mouse & Keyboard

v

Documentation & Tutorials

v

Acknowledgment

v Data Probe

n

None RAS: (125.0, -125.0, 1.0),



Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




After Adding Volume

¥ Laplace Operator (1) Note that Input Volume combobox
Input Volume: | spgr autoselected new volume

Output Volume: spgr
(2) Create new volume for output

’ Create new Volume
Delete current Volume R

|‘ Apply Laplace |

(3) Run the module

Run the Laplace
Operator.



Laplace Module

o -oom e _Result of Laplace Operator

@ Modules: _ | Hello Python Part C - Laplace | %

@ 3DSlicer

» Help & Acknowledgement

¥ Laplace Operator

Input Volume: | spgr 3

Output Volume: [Volume s

[ Apply Laplace N

Run the Laplace
Operator.

¥ Data Probe




@, 3DSlicer
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narpening with
olace Operator




Goals of this part

Add a processing option for image
sharpening
Implement this operation using a existing
Slicer Command Line Module



HelloSharpen.py

X=0

File Edit Tools

SRR SE wh e =N

from _main__ import vtk, qt, ctk, slicer

s [ El
=

#
# HelloPython
#

class HelloPython:
def init (self, parent):
parent.title = "Hello Python"
parent.categories = ["Examples"]
parent.dependencies = []
parent.contributors = ["Jean-Christophe Fillion-Robin (Kitware),
Steve Pieper (Isomics), Sonia Pujol (BWH)"] # replace with "Firstname Lastname (Org)"
parent.helpText = """
Example of scripted loadable extension for the HelloPython tutorial.
parent.acknowledgementText = """
This file was originally developed by Jean-Christophe Fillion-Robin, Kitware Inc.,
Steve Pieper, Isomics, Inc., and Sonia Pujol, Brigham and Women's Hospital and was
partially funded by NIH grant 3P41RR013218-12S1 (NAC) and is part of the National Alliance
for Medical Image Computing (NA-MIC), funded by the National Institutes of Health through the
NIH Roar’ap for Medical Research, Grant U54 EBO05149.""" # replace with organization, grant and thanks.
self.parent = parent

#
# gHelloPythonwWidget
#

class HelloPythonwidget:
def init (self, parent = None):
if not parent:
self.parent = slicer.gMRMLWidget()
self.parent.setLayout(qt.QVBoxLayout())
self.parent.setMRMLScene(slicer.mrmlScene)

else:
self.parent = parent
self.layout = self.parent.layout() [}

if not parent:

pen the file HelloSharpen.py
located in the directory HelloPython

# Helloworia outton

helloWorldButton = qt.QPushButton("Hello world")
helloWorldButton.toolTip = "Print 'Hello world' in standard ouput."
dummyFormLayout.addWidget (helloWorldButton)
helloWorldButton.connect('clicked(bool)’, self.onHelloWorldButtonClicked)

# Add vertical spacer
self.layout.addStretch(1)

# Set local var as instance attribute
self.helloWorldButton = helloworldButton

def onHelloworldButtonClicked(self):
print "Hello World !"
qt.QMessageBox.information(slicer.util.mainWindow(), 'Slicer Python', 'Hello World!')

HelloPython.py 22,8 AL




Add to Module GUI

Add this self.sharpen = qt.QCheckBox("Sharpen", self.laplaceCollapsibleButton)

Text in self.sharpen.toolTip = "When checked, subtract laplacian from input volume"
) self.sharpen.checked = True

section A self.laplaceFormLayout.addWidget(self.sharpen)



& Add to Processing Code

Add this #optionally subtract laplacian from original image

) if self.sharpen.checked:

TeXt,'n parameters = {}

section B parameters['inputVolume1'] = inputVolume.GetID()
parameters['inputVolume2'] = outputVolume.GetlD()
parameters['outputVolume'] = outputVolume.GetlD()
slicer.cli.run( slicer.modules.subtractscalarvolumes, None,

parameters, wait_for _completion=True )



In More Detail

slicer.cli gives access to Command Line
Interface (CLI) modules
CLI modules allow packaging of arbitrary
C++ code (often ITK-based) into slicer
with automatically generated GUI and
python wrapping



File Edit View Help
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| » Documentation & Tutorials B
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Go To Sharpen Module

&) Welcome to Slicer
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All Modules
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@ Volume Rendering
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£\ Welcome to Slicer
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Surface Models
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Re-start Slicer and select
module. Note the new
sharpen check box

Output Volume: \ Select a Volumi

¥ Sharpen

_{When checked,
subtract laplacian
from input volume




Add Volume Dialog

Wew Help
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£ - Select File -> Add Volume
Welcome
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Add spgr.nhdr

y [ open |
Look in: ’E/home/pieper/Dropbox/O_work/HeIIoPython = ’ o (= O @ @ ‘]
P pieper Name v Size Type Date Modif
9 data " HelloPython-Progra...er-2012-03-08.pptx 7.7 MB pptx File 3/12/12 3::

| HelloPython-Program...utorial_spujol.pptx 6.5 MB pptx File 3/7/12 9:3!
| HelloPython.py 1 KB py File 9/9/10 3:0!

EMOPYLNON. 21D 6.4 MB zip File 3/12/12 3:.
4B spr.nhdr N 351 bytes nhdr File 9/9/10 3:0
e g 6.4 MB gz File 9/9/10 3:0°

Load the dataset spgr.nhdr
located in the directory
. HelloPython/

File name: | spgr.nhdr | 4 Open |

Files of :| All (*.hdr *.nhdr *.nrrd *.mhd *.mha *.vti *.nii *.gz *. *img *.p 2 || '
iles of type ’ ( r *.nhdr *.nrrd *.m mha i *.nii *.gz *.mgz *.img *.p "‘xgancell

spgr Centered Ignore Orientation LabelMap
Options:

¥| Single File




After Adding Volume

7 Laplace Operator (1) Note that Input Volume combobox
Input Volume: | spgr autoselected new volume

Output Volume: spgr

‘ Create new Volume
Delete current Volume R

(2) Create new volume for output

(3) Run the module in Sharpen

¥ Sharpen mode

Run the Laplace or
Sharpen Operator.




2 3pslicer
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Sharpen Module

ﬁlfeﬂgd!ieéue:odu[esz ©, [Hello Python Part D - Sharpen | 4 | - G. QI A § O @ 7 .
T e Sharpening Operator on

3DSlicer

@®

» Help & Acknowledgement

¥ Sharpen Operator

¥| Sharpen

Input Volume: ‘ spgr

Output Volume: | Volume

Apply

¥ Data Probe

m

Result of Laplacian




& o Sharpen Module

Adjust Window/Level with

B& |Modules: O [HelloPython PartD-sharpen (2] ™ Q) © |1 &4 § @ @& @ 2 i .
2 Left-Mouse-Drag in Slice
d 3DSlicer .

» Help & Acknowledgement

¥ Sharpen Operator

Input Volume: | spgr s

Output Volume: | Volume s

¥! Sharpen

Apply

¥ Data Probe

-




Image Sharpening

3DSlicer

&

Laplacian filtered

Laplacian

original




Going Further

Explore numpy for numerical array manipulation
Review Endoscopy Module for interactive data
exploration using MRML and VTK

See the HelloWorld C++ tutorial for instructions
on writing CLI modules like the Subtract Scalar
Volumes

See the Editor Module for interactive

segmentation examples
Explore SimplelTK for image processing using ITK



Conclusion

This course demonstrated how to program custom
behavior in Slicer with Python

3DSlicer

@ python’
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